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1. Introduction 
 
myWorkbench is robust, powerful and advanced PalmOS® application file manager. myWorkbench lets 
you manage databases in RAM and files on the external card such as SD/MCC, Compact Flash and 
Memory Stick. In addition to the basic file management functions myWorkbench also does backup and 
restore databases from the external card, launch applications from ram and anywhere on the external card 
(PalmOS 5.0 only), maintain lists of orphaned databases, play wave files (only on the Palm® Tungsten), 
manage media type files, magicBin™ to save all deleted databases and applications from RAM to the 
card automatically (Only on PalmOS® 3.5x and PalmOS® 4.x), Hexview databases, compress and 
uncompress files, view doc, text and html files on PalmOS® 3.5 and OS 4.x and many more features.  
 

2. System Requirement 
 

• PalmOS® 3.5 and higher 
• 250K of free memory 
• External card optional 

 

2.1 Compatibility 
 

• Palm® Tungsten T/T2/T3/E, Palm® Tungsten W, Palm® Tungsten C, Palm® Zire 71/21, Palm® 
IIIc, Palm® IIIx, Palm® V, Palm® Vx, Palm® VIIx , Palm® M100, Palm® M105, Palm® 
M125, Palm® M130, Palm® M500, Palm® M505 and Palm® M515 

• Handspring® Visor, Prism® and Treo® series 
• Sony Clie® series all models 
• Samsung® smartphone 
• Acer® 
• Kyocera® smartphone 
• HandEra® H330 
• Legend® 
• Garmin® 
• Tapwave® Zodiac 

 

3. Installation 
 
To install myWorkbench double click on the files myWB.prc, SysZLib.prc and then press the HotSync® 
button on the cradle. The HotSync® manager will then install the files on to your Palm. 
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3.1 PamOS® 3.5 and PalmOS® 4.0 
 
Included in PalmOS® 3.5 and PalmOS® 4.x is magicBin™.  To install magicBin™ unzip the magicBin 
file and double click on the file magicBin.prc.  See magicBin manual in the zip file. 

 

3.2 myWorkbench Theme 
 
myWorkbench Theme comes with a wall paper and different button icons for different Palm devices. 
Install myWBTheme.pdb file to your Palm. Make sure you install the correct version in the following 
folder. 
 
Folder Name For Palm 
myPictures\PalmOS5 320x320 Palm Tungsten T/C/W, Z71 Sony TG (320x320) 
myPictures\SonyNX_NV_NZ 320x480 Sony Clie NX, NV or NZ (320x480) 
myPictures\SonyT_S_Series 320x320 Sony Clie T and S series (320x320) 
myPictures\8bit color_greyscale 160x160 All Palms with 8bit color and greyscale 
 
You can install myWBTheme.pdb in ram or move the file to the card in /myPictures folder.  If the theme 
cannot be found then the default theme will be used. 
 

4. Launching myWorkbench 
 

4.1 Sony Clie® High Resolution for PalmOS® 4.x 
 
If myWorkbench does not display in high resolution then exit myWorkbench to the Launcher and launch  
 

the Prefs  application and select HiRes from the popup and place a check mark in the Enable 
High Resolution Assist checkbox. See the below diagram. 
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Diagram: Sony High Resolution Assist 

 

From your Launcher look for the icon  or  and tap on it launch it.  If you cannot find 
the icon use the scroll bar and scroll down. 

5. myWorkbench Desktop 

 
myWorkbench is designed differently from the traditional file manger.  When you launch myWorkbench 
the first thing you will see is myWorkbench’s desktop.  See the following diagram. 

 
Diagram 1: myWorkbench desktop with Theme 
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5.1 myPalm 

 If you want to explore the databases in RAM you tap on the myPalm icon.  This will 
open the RAM explorer window. 

5.2 myCard 

 If you want to explore the databases and files on the card you tap on myCard icon. This 
will open the Card explorer window. 

5.3 TranshCan 

The Trash Can is a placeholder for all your deleted files. myWorkbench does not 
automatically put the deleted file in the Trash Can when you delete a file.  If you want to delete a database 
or a file and want to keep a backup copy you will have to manually move the database or file to the Trash 
Can folder in the Explorer window. 
 

5.4 myWorkbench Desktop Menus 

5.4.1 Options Menus 
 

 

Diagram 2: myWorkbench Options Menu 
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The Options menu is only available on the Desktop and its not available in the Explorer windows eg: 
myPalm or myCard. 

 

5.4.2  Preference 

 
Diagram 3: myWorkbench Preference 

 
Descriptions 
 

□ Show ROM apps & Databases – if this is checked myWorkbench will not show databases and 
applications that are in ROM.  Read Only Memory databases and applications are files that are burned 
into the PalmOS® and cannot deleted. 

□ Show a68K temp files – if this is checked myWorkbench will show all the files that PACE creates.  
These are temporary files for the ARM® environment. 

□ Turn on icon Help – if this is checked myWorkbench will display the help text when you tap on the 
icon in the tool bar. 

□ Prompt when deleting files - if this is checked myWorkbench will prompt you each time you delete a 
database or a file. 

□ Show Picture on Wake & Sleep – if this is checked myWorkbench will display a picture when the 
Palm is shut down and during start up. Please email as at support@toysoft.ca or visit our website at 
http://www.toysoft.ca/mywb4.html to download the startup pictures. 
 
Note: On the Sony® myWorkbench does not support the Sony® launcher.  It will crash if you turn 
this feature on.  myWorkbench supports 3rd party launchers such as SilverScreen, Zlauncher, 
LauncherX and many others. 
 
Do not turn on this feature if you have wavAlarms installed on your Palm. 
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□ Play Sound on Wake & Sleep – if this is checked myWorkbench will play a wave from the card 
when the Palm is shut down and during start up.   Install wave files to the card in the Audio folder and 
rename them wake.wav and sleep.wav.  For the Sony® Clie please refer to the section in Converting 
wave files for the Sony® Clie 

□ Use SMS/BlueTooth for Beaming – If this is checked myWorkbench will prompt you to select SMS 
or Blue Tooth when beaming a file. 

□ Delete files after zip/unzip – If this is checked myWorkbench will delete the original files after the 
files have been zipped or unzipped. 

□ Enable myWB Theme  – If checked then themes will be used. You can then select a wall paper. 
 

 - Wallpaper lets you select any JPG file to use as the background picture.  WallPaper 
requires the myWBJPG viewer to be installed.  This feature is only available for PamOS® 5 and higher. 
 

5.5 Changing myWorkbench Colors 
 
myWorkbench starts with the default color scheme showing below. 
 

 
Diagram 3.1: myWorkbench Color Scheme 

 

5.6 Backup Files 
 
myWorkbench can backup all the databases and applications from RAM to the card.  myWorkbench 
creates a folder called /Backup on the card.  Each time you do a new backup myWorkbench will create a 
new folder and will copy all the databases and applications there.  You can select to backup all files, 
applications only or databases only. myWorkbench can also compress all the files during backup.   
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Note: myWorkbench uses Zlib to compress and decompress files. Compression is a slow process and it 
could take a long time to backup your entire Palm. 

 
Diagram 4: myWorkbench Backup 

 
The above diagram shows the backup files and memory size needed for the backup.  Tap on the Backup 
Type: popup to select the type of back up you want.  myWorkbench will update the file count and size. 
 
To compress all the files check the Compress Files checkbox. The files will be compressed and saved to 
the backup folder on the card. All the files will have the extension .zip.  myWorkbench does not compress 
all the files into one single file.  They are individually compressed. 
 
Note: Files zipped with myWorkbench can be unzipped on the Windows desktop with programs such as 
WinRAR® and Winzip® 
 
Auto Backup 
 
To program the auto backup feature tap on the popup and select the type of auto backup.  myWorbkench 
will do a backup at midnight for the selected day.  
 
Note: during auto backup myWorkbench does not compress the files. 
 
Card Section 
 
myWorkbench supports multiple volumes.  You can select the card to which the files will be backup to by 
selecting  popup control. 
 
Start Manual Backup 
 
If you do not have enough memory on the card the Start… button will not be visible and a message will 
be displayed.  You cannot perform a backup if there is not enough RAM on the card. 
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You must use myWorkbench to restore your backup especially if the files are compressed. 
 
If Zlib library is not installed on the Palm then the Compress Files… checkbox will not be visible. 

 

 
Diagram 4.1: Backup Message 

 
When you start the backup you will be prompted with the above message. To begin the back up process, 
tap on the OK button. To cancel the back up, tap on the Cancel button.  If you don’t have enough memory 
on the card myWorkbench will display an error message. 
 
Caution: Do not remove the memory card during backup and restore. If you do you could potentially 
damage the card and render inoperable. 
 

5.6.1  Daily Backups 
 

If you had selected Daily Backups  you can select how many backup 
copies to keep before myWorkbench rotates the backup.  Eg: if you had selected to Keep 3 days of 
backups then myWorkbench will backup 3 days of new backups before it rotates.  During the rotation the 
old backup is deleted before the new backup.  So after 3 days of backups the first day’s back is deleted 
and a new backup is performed on the 4th day. 
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5.6.2  Weekly Backup 
 
A weekly backup is performed once every week.  Example if you had selected: 
 

 
myWorkbench will backup every week at Sunday.  A new backup will be created and there is no rotation 
like the daily backup.  You must manage the backups so that you card will not be filled. 
 
 

5.6.3  Restoring a Backup 
 
The restore function lets you restore databases and applications from a backup.  Restore is usually used if 
your Palm was cold booted.  
 
Cold Reset 
 
After a cold reset launch myWorkbench from the card.  There should be a copy of myWorkbench in the 
/palm/launcher folder unless you have deleted yourself.  Goto the Options menu and select the menu item 
Restore… The following window will be displayed. 
 

 
Diagram 5: Restore Window 
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Multiple Volume Support 
 
You can select the card to which to restore from by selecting the popup.   
 
EruWare Compact Flash Driver 
 
When you cold boot the Palm the EruWare Compact Flash driver will not be available and you cannot 
restore from the Compact Flash card until you install the EruWare driver and mount it. 
 
The Restore window lists all the available backups to restore from the selected volume.  The backup file 
name is read as follows: 
 
Back up name from item 2 from the diagram. T2002_1116.095157 
 
T2002 – means it was backed up in year 2002 
1116 – means the month and day.  1116 means November 16 
095157 – after the period is the time that was backed up.  09 – nine am, 51 – minutes, 57 seconds 
 
To restore a given backup select the back up date in the list and then select the Restore… button. To 
cancel the restore, select the OK button and return to the Desktop. 
 
 
Compression Library 
 
myWorkbench  copies itself and the zlib compression library to the card in /palm/launcher folder.  When 
you cold boot your Palm all the files are lost.  When you restore a backup using myWorkbench, 
myWorkbench requires the zlib in ram because files maybe compressed during the backup.  Prior to 
myWB 4.8 you must copy the zlib manually.  Now myWB will always makes sure the zlib exists in ram 
and on the card. 
 
If you get an error message saying that the zlib library is not found then just use myWB to copy the zlib 
files from the card in /palm/launcher to ram. 
 

5.7 Orphaned Databases 
 
Orphaned databases are databases that do not belong to an application.  Orphaned databases typically 
happen when an application creates a database and does not assign the application creator id to it. This 
becomes a nightmare when the application is deleted from the device and the databases that it created are 
not deleted. Take this example.  You have just installed a new application called KillerApp and when you 
launched KillerApp it creates several databases that it does not own.  You then realized that KillerApp is 
not what you thought a Killer application would be and you deleted it from the Launcher. Now you have 
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several orphaned databases left on your Palm and is taking up valuable RAM.  This is where Orphaned 
Databases feature comes in handy. 
 

 
Diagram 6: Orphaned Databases 

 
The Orphaned window lists all the orphaned databases in RAM.  myWorkbench does not show orphaned 
databases on the card.  If you know that an orphaned database in the list you can select it and then delete 
it. The best way to do this is to show the list with Creator and Type. You do this by selecting the View 

icon  from the Toolbar. 
 
Caution: Be very careful when dealing with orphaned databases.  Some orphaned databases are used by 
the PalmOS® and should not be deleted. Eg: Saved Preference and psysLaunchDB are system 
databases and if you delete them your Palm may not work properly and would require a cold boot and 
restore. 
 

5.8 Media Type Manager 
 
To launch Media Type manager select the Options menu from the myWorkbench desktop. 
 
Media Type Manager lets you manage file types during HotSync® to the external card.  Typically during 
HotSync® all PalmOS® databases (.pdb and .pqd) and applications (.prc) are installed in the default 
/Palm/Launcher folder on the card.  For non-Palm files you must register the file type with the 
PalmOS® before HotSync® Manager will install the file to the card.  For example: Files with the 
extension .gif and .jpg are installed to the /DCIM/ folder on the card and extension .wav are installed to 
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the /AUDIO/ folder.  All these are default paths.   With myWorkbench Media Type Manager you can 
change the default paths and have HotSync® Manager install the files to a different location on the card. 

 
Diagram 7: Media Type Manager 

 
Note: Media Type File Manager is only available and works for devices that have external card support. 
 
To Unregister a Extension 
 
To un-register an extension select the extension from the Media File Type: toggle box and then select the 
Unregister button. If an extension is already registered to a default folder you will have to un-register it 
first before you re-register it to a different default path. 
 
To Register a Extension 
 
To register a file type extension tap on the toggle button below the Media File Type: label and a list of 
default extensions will be displayed.  Select the extension you want to register.  The default path will be 
displayed.  If there is no default path registered then you will see “Tap here to register default path” 
under the Default Path: toggle box. Tap on the toggle button below the Default Path: and the following 
window will be displayed. 
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Diagram 8: Select default directory 

 
Navigate the directory tree until you find the folder you want to register and then select the OK button. 
You can also create a new folder by selecting the Create… button.  The Back button will move you back 
to the previous folder. To cancel select the Cancel button. 

 
myWorkbench System Folders 
 
See 10. myWorkbench System Folders section. 
 
Note: When you do a soft reset to your Palm, media type association is lost and you will have to select 
them again use Media Type File Manager.  
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5.8.1 About 
 

 
 
 

Diagram 9: About 
 
 

5.9 System Menus 
 

 
 
 
 

Diagram 10: myWorkbench System Menu 
 
 
 
 
 
 



 
myWorkbench User Documentation Version 5.2
 

myWorkbench User Documentation Toysoft, Inc. Page 17 of 40
 
 

5.9.1 Info 
 
Get information about your Palm. 

 
Diagram 11:  Palm and Card info 

5.9.2 Format Card 
 
If you have a new external card you can format it by selecting the Format… menu item. All data on the 
card will be erased and cannot recovered. The following confirmation dialog will be displayed.  
Additional dialog may be displayed. 
 

 
Diagram 12:  Format Card 

 
Caution: Do not remove the memory card during formatting. If you do you could potentially damage the 
card and render inoperable. 
 
EruWare Compact Flash Driver 
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Formatting the Compact Flash card using EruWare driver does not work at this point. 
 
 

5.9.3 Rename Card 
 
To rename the external card select Rename Card… from the menu item. 
 

 
Diagram 13:  Rename Card 

5.9.4 Soft Reset 
 
To perform a soft reset, select the Soft Reset… menu item. Data will not be lost during a soft reset. 
 

 
 

Diagram 14:  Soft Reset 
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6. myPalm Explorer 
 
myPalm Explorer lets you explore databases and applications in RAM. Depending on the Preference 
settings myPalm Explorer may only display certain files.  If some files are missing then check the 
Preference setting. 
 

 
 

Diagram 15:  myPalm Explorer 
 

6.1 File Action Popup 
 
To display the file action popup, select a file or files and then keep the pen down.  The action item is the 
same as tapping on an icon in the toolbar.
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7. myCard Explorer 
 
myCard Explorer lets you explore files on the card.  
 

 
Diagram 16:  myCard Explorer 

 

8. Explorer Icon Toolbar 
 
The icon toolbar performs action on all the selected items or files in the list. Eg: if you selected three 
items and select the Delete icon all the selected files will be deleted. 
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Diagram 17:  Explorer icons for PalmOS®  5.0 and Sony color Clie® 

 
Diagram 17a:  Explorer icons for PalmOS® 3.x and 4.x higher 
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8.1 Previous Folder 

  This icon is only active in myCard explorer view. This will move one up in the directory tree to 
the previous folder. You cannot move up anymore if you are at the root tree ‘/’. 

8.2 Delete Files and Folder 

  This icon will delete all the selected databases, applications or files. If a folder is selected all the 
files and subfolders within that folder will be deleted.  Databases and Applications that are Copy 
Protected will be deleted. ROM databases and applications cannot be deleted. 

8.3 Copy Files and Folder 

  This icon will copy all the selected files to the destination. 
 
View Type Source (Active View) Destination 
Full View myPalm (RAM) You select a folder 
Full View myCard (Card) RAM 
Split View myPalm (RAM) Current folder 
Split View myCard (Card) Current folder 
 

Table 1: Copy mode 
 
When copying folders to folders from the external card all sub-folders will be copied. 
 

8.4 Move Files and Folder 

 This icon will move all the selected files to the destination. 
 
View Type Source (Active View) Destination 
Full View myPalm (RAM) You select a folder 
Full View myCard (Card) RAM 
Split View myPalm (RAM) Current folder 
Split View myCard (Card) Current folder 

 
Table 2: Move mode 

 
When moving folders to folders from the external card all sub-folders will be moved. 
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8.5 File and Folder Information 

 This icon will give you information on the selected files and folders. 

 
Diagram 18:  File Properties 

 
Caution: When getting information for the folder, do not remove the external card. 
 

8.5.1 Changing The File Attributes 
 
When the Apply button is enabled you can change any for available file attributes such as Creator ID, 
Creator Type and file name.  Tap on the Attributes tab to show the file attributes.  To apply the changes 
tap on the Apply button. 
 
Caution: Be very careful when you start changing file attributes.  The program may not work properly if 
it’s modified. 
 

8.6 Open a Folder 

 This icon will open the selected folder on the card.  You can also double tap on the folder in the 
active list view to open it. 
 



 
myWorkbench User Documentation Version 5.2
 

myWorkbench User Documentation Toysoft, Inc. Page 24 of 40
 
 

8.7 Create a New Folder 

 This icon will allow you to create a new folder in the current folder. Keep the folder name short 
to avoid problems. 
 

8.8 Beam Files 

 This icon will beam the selected files to another device.  Unlike the PalmOS® Launcher 
myWorkbench will beam Copy Protected databases and applications. 
 

8.8.1 Beaming from the Card 
 
myWorkbench can beam any files on the card.  To beam just select the file and tap on the beam icon. 
 

8.8.2 Receiving a Beam 
 
When receiving a non .pdb and .prc file myWorkbench will store the file in the /myReceivedFiles folder 
on the card.  myWorkbench supports the following file extensions: 
 
.C,  .H, .CVS, .BMP, .JPG, .DOC, .TXT, .XLS, .MP3, .PNG, .HTML, .ZIP, .PDF, .GIF, .EXE 
 

8.9 Play Wave Files (Palm Tungsten Only) 

 This icon will try to play the selected wave file.  If the file is not a wave file an error message 
will be displayed.  myWorkbench can only play wave files on the card. When playing wave files 
myWorkbench will play the entire file until it is finished before giving control back to the PalmOS®. 
 
Note: Currently playing wave files is only supported on the Palm Tungsten T® model. 
 

8.9.1 Playing Kinoma™ Videos 
 
If you have Kinoma player installed on your Palm you can select the movie file and then select the Music 
icon to launch it.  You can play video in RAM or on the card. 
 

8.10 Launching Files and Databases 

 This icon will attempt to launch the selected database or application or view it.  You can select a 
database name to launch and myWorkbench will find the application that is associated to it. Eg: if you 
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select the AddressDB file myWorkbench will launch the AddressBook.  When launching by database 
name myWorkbench does not send the database name to the launching application. 
 
Note: You can double tap on the item to launch it. 
 
Supported Application Databases 
 
You can launch the application’s database directly. Select the database then tap on the Launch icon. 
 
Here are the list of applications that myWorkbench can launch directly. 
 

• Acrobat  Reader v2.0 
• QuickWord v6.0 
• Kinoma player v1.5.1 
• JPG files. (need myWBJPG viewer) 

 
General Text File View 
 
If myWorkbench cannot find the application that is associated to the database or file it will launch the 
internal text viewer.  The viewer can view any text files, raw html files, C/C++ and H files, binary files 
will be read as text and might not display properly. 
 

8.10.1 Launching from the Card (PalmOS 5.0 Only) 
 
You can launch an application or database anywhere on the card.  myWorkbench first copies the 
application and all the databases that are associated to the application to RAM and then launch it.  If the 
application and databases are big it could take several seconds or even minutes to copy to RAM before it 
is launched. 
 
When you exit the launched application myWorkbench will copy all the databases that belongs to the 
launched application back to the location where the application was launched on the card.  This is unique 
in myWorkbench and it will ensure that any modified or created databases get sync’ed back to the card.  
You will never had to worry about losing data when launching applications from the card. 
 
Note: Launching application from the external card is only available on PalmOS® 5.0 and higher. 
 

8.11 View Types and Sorting 

 This icon allows you to change the view type and sorting order. You can also hide and show 
icons in the list. 
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8.12 Toggle myPalm and myCard Explorer 

 This icon allows to you select between myPalm and myCard explorer.  Full view will be the 
default view. 
 

8.13 Sorting 
Besides sorting by selecting the View Types icon, you can also sort the list by tapping on the Column 
heading ( ).  The Up arrow indicates that the sort is by ascending.  The Down arrow 
indicates descending.  
 

9. Full View and Split View 

 
Diagram 19: View Modes 

 
Full view mode always displays myPalm files which is RAM files. 
In the Full View mode file size and file date are showing as default.  Alternatively you can view it by 
creator id and type by selecting the View icon from the Tool bar. 

 
PALM RAM 

 
When displaying RAM files some icons are disabled and they are only enabled in myCard explorer 
window. These icons are: Previous Folder, New Folder, Open Folder and Play Wave files. 
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9.1 Split View Mode 
 

The default split view is left view is RAM files and the right view is the card files. If no external card is 
available then both views will be the same. 

To switch between Full View and Split View select the icon . At anytime you can switch between 

myPalm and myCard explorer by selecting the icon . This will put the list view in full view mode. 

In the split view you can select the icon  to toggle between myPalm and myCard explorer view. You 
can have both views the same media.  

 

9.2 Active View 
 

The active view is high lighted by a blue box. All action will be applied to the active view.  Eg: if you are 
copying files the source view will be high lighted and the destination view will not be high lighted.  As 
you tap around the screen the high light box changes to reflect the active view. 

 

9.3 Tungsten T® D-pad Support 
myWorkbench supports the Tungsten T® D-pad. 
 
View Mode Left Button Right Button Center Button 
Full view 

 Move up a folder.  
Only if the active view is 
myCard 

None 
 Select Explorer view 

Split view Make the left view active Make the right view 
active  Select Explorer view for 

the active view 
 

Table 3: D-pad support 
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9.4 Explorer Menus 

 
Diagram 20: Explorer menus 

 
See section 8. Explorer Icon Toolbar. 
 

• Select All – Select all the items in the list 
• Unselect All – Unselect all the items in the list 

9.4.1 Hex View  
To hex view a database or an application tap on the file you want to view then tap on the Menu button and 
select the menu item Hexview… The following window will be opened. 

 
Diagram 21: Hex view 



 
myWorkbench User Documentation Version 5.2
 

myWorkbench User Documentation Toysoft, Inc. Page 29 of 40
 
 

The file will be displayed in hex view.  The top lists all the records or resources in the database.  Use the 
arrow to scroll thru the items.  When you tap on a item the hex data will be displayed.   Use the scroll bar 
on the left to scroll down for more data. 
 
The check boxes show the record’s attributes.  If the Apply button is visible you can change the record 
attributes.  Be careful when you change the attributes. It may affect the way the application handles the 
modified record. 
 
Buttons 
 

• OK – Return to the Explorer view 
• Apply – Change the attributes 
• Del… - Delete the selected record from the database. 
• Copy – Copy the selected record and not added to the database yet. Use Paste to add it. 
• Paste – Paste the copied record to the database 

 

9.4.1.1  Viewing Bitmap and Playing Wave resources 
 
To view the bitmap resource type ‘Tbmp’ select the record and then select the menu item View Bitmap… 
myWorkbench™ will try to view the bitmap.   
 
To play a wave file resource type ‘wave’ select the record and then select the menu item Play Wave… 
myWorkbench™ will try to play the wave resource.  Note: Playing wave resource file is only available on 
the Palm® Tungsten T. 
 

9.4.2  Zip and Unzip Files 
 
To zip and unzip files you need to install the SysZlib.prc.  You can zip files in ram or stored on the 
memory card.  To zip or unzip files select the files and then select the Edit->Zip/UnZip menu item.  
myWorkbench will prompt you with this message: 
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If you want to keep the original files after zip or unzip then select the OK button.  If you do not want to 
keep the original files then select the Cancel button. 
 
The following text is taken from http://www.copera.com/zlib-armlet/index.html 
 
The following table shows deflate and inflate speeds on a device with a 68K processor (m515) and on a 
device with an ARM processor (Tungsten T). Results were obtained by running Deflater on the 
Asian_24x24.PDB 1.25 Meg Anki font database. 
 

 
 

9.4.2.1 Windows Desktop Zip Files 
 
myWorkbench can unzip files created by Winzip on your Windows desktop.   myWorkbench will 
decompress the files into the current folder.  If the zip file contains subdirectories myWorkbench will 
retain the original folder structure. 
 
WinRAR® and Winzip® 
 
Files that are zipped with myWorkbench on the card can be unzipped using WinRAR® and Winzip® in 
Windows®. 
 

9.4.3 Export Directory Listing to MemoPad 
 
Select the menu item Export to MemoPad… to export the current directory listing.  The record in 
MemoPad will be comma delimited.  The format is as follows: 
 
Path name, filename, file extension, file size, number of records, type, creator id, date 
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9.5 Quick Search 
 
In the explorer window if you write a letter myWorkbench will search the list of all items and will scroll 
to there.  Nothing will happen if the letter is not found. 
 

9.6 Filters 
 
Using the Filters you can narrow the file selections and only browse at the files that you are interested in.  
In the Explorer window select the Edit->Filters menu.  The following window will be displayed. 

 
 

When searching for file name it is case sensitive. For example A is different from a. myWorkbench will 
find the file if the search text is in the file name eg: if you search for “add” the following files will be 
returned.  address, addictive 
 
The creator and type are four characters code that identifies the file and type. 
 
The file size is kilobytes and not the actual size. 
 
The Filter search is OR condition meaning that the match is TRUE if any of the items in the search 
matches the file.  This is not a AND search where Creator and Type have to be in the file to be true. 
 
Explorer View and Search All 
 
After you have performed a filter search the Explorer window will display the found items at all times 
until you perform a new search.  Selecting from RAM and the card view will not refresh the browser 
items.  You will have to perform a search all or close the Explorer window and return to the Desktop 
window. 
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To perform a search all open the Filters window and just select OK.  By default if you don’t enter and 
search criteria myWorkbench will list all the files. 
 

10. myWorkbench System Folders 
 
There are several system folders that myWorkbench creates. 
 

 
 
These system folders cannot be deleted. You can delete the contents.  You should use myWorkbench 
Media Type Manager to register .doc, .wav, .jpg, .gif and other files to the system folder. 
 

11. View files with MultiMail Plugins for PalmOS® 3.5 and 4.x only 
 
myWorkbench uses MultiMail Pro® plugins to view files on the card. Currently myWorkbench supports 
the following file formats: .doc, .csv, .text, .html, .c, .cpp and .h files. 
 
You do not required to install MultiMail Pro® on your Palm. Here are the links to all the supported 
plugins.  Download them and install them on to your Palm. These plugins may not be available anymore. 
Please contact us at support@toysoft.ca if you need assistant. 
 
MSWord Viewer Freeware 
http://www.palmgear.com/software/showsoftware.cfm?sid=48337320020727053013&prodID=1876 
 
HTML Viewer Freeware 
http://www.palmgear.com/software/showsoftware.cfm?sid=48337320020727053013&prodID=2008 
 
Text Viewer Freeware 
http://www.palmgear.com/software/showsoftware.cfm?sid=48337320020727053013&prodID=1782 
 
CSV Viewer Shareware 
http://www.palmgear.com/software/showsoftware.cfm?sid=48337320020727053013&prodID=3486 
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To view a file you first select the file and then tap on the Launch icon  in the Explorer window. 
myWorkbench will then attempt to launch the MultiMail plugin. 
 

12. Converting Wave file to Sony® Clie Format 
 
Included in the myWorkbench archive there is the Windows ConvertPCM.exe application.  In order for 
myWorkbench to use wave files you must convert the wave file to following format: 
 
 
 16bit mono 8 khz 
 
A good Windows sound converter application is GoldWave and you can get a trial version at 
http://www.goldwave.com/  
 

 
 
Use the Browse button to browse to the wave file. Click on the Convert button to convert the file.  After 
conversion the file will be saved in the same folder.  The extension .bin will be added.   
 
HotSync® the Wave .bin File 
 
The converted wave file cannot be synced to the Palm® main memory.  It must be synced to the Memory 
Stick.  Do the following: 
 
   
 On the Palm  
 

Launch myWorkbench to register the new .bin file extension.  
 
 On Windows Desktop 
 

1. Open the InstallTool from your desktop computer 
2. Browse to the converted wave file 
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3. Drag and drop the wave file on to InstallTool 
4. In InstallTool the Destination will read Memory Stick 
5. Press the HotSync® button on the cradle. The file will be synced to the folder /Audio on 

the Memory Stick. 
6. Launch wavAlarms and Test or Player the file. 

 
Note: The wave file can be any size as long as you have enough main memory to load it.  If you only have 
1 meg of free main memory and the wave file on the card is 2 megs then wavAlarms will not be able to 
play it. 
 
 

12.1 Converting a Wave File using GoldWave Tutorial 
 
In the included zip main archive you will find a folder called SonyTutorial.  In the folder is a wave file 
named Cool.wav.  Launch GoldWave and load in the wave file Cool.wav.  In GoldWave you will see the 
following screen. 
 
 

 
 

Do following: 
 

1. In GoldWave select the Effects menu 
2. Select Resample menu item.  The following window will be opened. 
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In the Rate (Hz) drop down window select 8000 as shown in the above diagram.  For the Sony® 
you must select 8000 as high rate will give you very poor results. Select the OK button. 

 
3. The wave file is now re-sampled to the rate that Sony® Clie and play. 

 
 

4. Select the File->Save As menu and the following save as dialog will be displayed. 
 

 
 
  Enter the filename as Cool8k.wav. Make sure you set the following: 
 

• Save as type: Wave (*.wav) 
• File Attributes: 16 bit, mono, signed 
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Select Save when you are done. 
 

5. Launch ConvertPCM application  
 

 
 

 Select the Browse button and browse for the file Cool8k.wav.  Select the Convert button. A new 
file called Cool8k.wav.bin file will be created in the folder where Cook8k.wav is located. 

 
 

6. Following the section in HotSync® the Wave .bin File from above to HotSync® the 
wave file to the Palm. 

 
 
 

12.2 Download Wave Files 
 
There are many sites on the Internet where you can download wave files.  Here are some sites: 
 

• http://www.aleshas.com/ Sound files and ringtones. Supports many Palm devices 
• http://www.allwavs.com  Files are compressed. You need to uncompress them. 
• http://www.wavcentral.com 
• http://www.wavethemes.org 
• http://www.geocities.com/Hollywood/Theater/6219 
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13. Viewing JPG on PalmOS® 5.x Palms 
 
With myWorkbench 5.0 you can view jpg files on the memory card.  You need to install the jpg plugin 
myWBJPG.prc to RAM.  myWBJPG.prc can not be stored on the card. The plugin can not view 
progressive images or very large images.  The plugin is designed to view images from the digital camera 
or the Palms camera.   
For large image the image will be scaled to fit screen resolution.  It varies from device to device.  On the 
Palm® Tungsten it will be 320x320 and on the Sony® NX it will be 320x320 or 320x480. 
 
Note: if the plugin can not read the image it will crash your palm. 
 
Viewing JPG 
 
To view an image just double tap on the image or select the file and then select the Launch icon on the 
toolbar.  The plugin will then display the picture. 
 

 
myWBJPG viewer 

 
Image Zoom Support 
 
The plugin has basic zooming.  When zoomed the image will not be centered on some Palms like the 
Tungsten T.  On the Sony® device eg: TG50 you can zoom up to 3 levels and do scrolling. To scroll, tap 
on the screen and move the stylus around. 
 
To exit the plugin press any hard key button or the home key to return to myWorkbench.
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14. User License 
 
(a)Toysoft, Inc. Hereby grants you a non-exclusive license to use its accompanying software product 
("Software") according to the following agreement: 
 
(b)You may: use the Software on only one (1) PalmOS® handheld computer. 
 
(c)You may not: permit other individuals to use the Software except under the terms listed above; modify, 
translate, reverse engineer, decompile, disassemble, or create derivative works based on the Software; 
copy the Software (except for back-up purposes); rent, lease or otherwise transfer rights to the Software; 
or remove any proprietary notices or labels on the Software. 
 
Toysoft, Inc. reserves all rights not expressly granted to Licensee. 
 
 

15. Copyright 
 
Ownership rights and intellectual property rights in and to the Software shall remain in Toysoft, Inc.  The 
Software is protected by the copyright laws of Canada and international copyright treaties.  This License 
gives you no rights to such content. 
 
EruWare Compact Flash Driver ©2003 EruWare. 
 
JPG © Independent JPEG Group.  
 
Armlet port by Matthew Fleming. 
 

16. Disclaimer 
 
(a)DISCLAIMER OF WARRANTY. The Software is provided on an "AS IS" basis, without warranty of 
any kind, including without limitation the warranties of merchantability, fitness for a particular purpose 
and non-infringement. 
 
(b)You and not Toysoft, Inc. assume the entire cost of any service and repair.  In addition, mechanism 
implemented by the Software may have inherent procedural limitations, and you must determine that the 
Software sufficiently meets your requirements. 
 
(c)This disclaimer of warranty constitutes an essential part of the agreement. 
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17. Limitation of Liability 
 
UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT, CONTRACT, OR 
OTHERWISE, SHALL TOYSOFT, INC. OR ITS SUPPLIERS OR RESELLERS BE LIABLE TO YOU 
OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION 
DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR 
MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR LOSSES. 
 
 

18. Termination of License 
 

This license will terminate automatically if you fail to comply with the limitations described above.  On 
termination, you must destroy all copies of the Software 
 

19. Technical Support 
 
For technical support please send email to support@toysoft.ca or visit our website at www.toysoft.ca 
 

20. Zlib compression library 
 
Copyright (C) 1995-1998 Jean-loup Gailly and Mark Adler 
Copyright (C) 1995-2002 Jean-loup Gailly. 
 
Jean-loup Gailly        Mark Adler 
jloup@gzip.org          madler@alumni.caltech.edu 
 
Zlib armlet port by  

Copera 
650 Castro Street 
Suite 120-216 
Mountain View, CA 94041 
Copyright © 2003 
http://www.copera.com 
 


